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Important Notes 
 
A knowledge of combustion related procedures and commissioning is essential before embarking work on any 
of the M.M./E.G.A. systems. This is for safety reasons and effective use of the M.M./ E.G.A. system. Hands 
on training is required. For details on schedules and fees relating to group training courses and individual 
instruction, please contact the Autoflame Engineering Ltd. offices at the address listed on the front. 
 
 
Short Form - General Terms and Conditions 
 
A full statement of our business terms and conditions are printed on the reverse of all invoices. A copy of these 
can be issued upon application, if requested in writing. 
 
The System equipment and control concepts referred to in this Manual MUST be installed, commissioned and 
applied by personnel skilled in the various technical disciplines that are inherent to the Autoflame product 
range, i.e. combustion, electrical and control. 
 
The sale of Autoflame’s systems and equipment referred to in this Manual assume that the dealer, purchaser 
and installer has the necessary skills at his disposal. i.e. A high degree of combustion engineering experience, 
and a thorough understanding of the local electrical codes of practice concerning boilers, burners and their 
ancillary systems and equipment. 
 
 
Autoflame’s warranty from point of sale 
 

• Two years on all electronic and electro-mechanical equipment, assemblies and components.  
• One year on all EGA systems and UV & IR scanners, including parts, components, cells and sensors.  

 
The warranty assumes that all equipment supplied will be used for the purpose that it was intended and in 
strict compliance with our technical recommendations. 
 
Autoflame’s warranty and guarantee is limited strictly to product build quality, and design. Excluded absolutely 
are any claims arising from misapplication, incorrect installation and/or incorrect commissioning. 
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Important Note 
 
Autoflame may release updated versions of the software listed in this guide for the purpose 
of enhancing the features and improving performance. Please make sure that you always 
upgrade to the latest released version of Autoflame software. 
 
Autoflame approved Tech Centres and registered OEMs can check for the latest available 
software versions on the software section of our technical website tech.autoflame.org  
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1. DOWNLOAD MANAGER 

1.1. Overview and Compatibility 

Autoflame Download Manager allows the user to download and upload data from and into the following 
Autoflame devices: 
 

• Mk8 MM 
• Mk8 Mini MM 
• Mk8 EGA Evo 
• Mk8 DTI 

 
Autoflame Download Manager is compatible with any PC running Windows 7, 8 or 10, both 32 and 64bit 
formats are supported. The software must be installed in Administrator Mode. 
 
Note: Please make sure that you always upgrade to the latest version of Autoflame Download Manager 
software. Please check the software section on our Tech website tech.autoflame.org for the latest available 
version or contact Autoflame.  
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1.2. Serial Number and Activation Code 

The IR lead (pt. MM60010) can be used for both the IR Upload/ Download software and the Download Manager 
software. Bluetooth connectivity doesn’t require the purchase of any special hardware. 
 
When installing the Download Manager software onto a PC, a unique License Code is generated for that PC; 
an Activation Code will be required to activate the Download Manager software for that License Code. The 
Download Manager software can be purchased in the following three ways: 
 
Purchase MM80010 
 

1. You will receive an IR lead and the Download Manager software on a USB stick with a Serial Number. 
2. Install Download Manager software onto PC. 
3. Go to http://www.autoflame.com/download-manager/ and request an Activation Code using the serial 

number on the USB stick. 
4. If the Activation Code has not already been sent for that Serial Number, we will send you the Activation 

Code to activate this software. If an Activation Code has already been sent for that Serial Number of 
Download Manager software, we will require a Purchase Order for a new Serial Number (part number 
MM80010NLB). Then submit a new request for an Activation Code using the new Serial Number given 
with the Order Acknowledgement. 
 

Purchase MM80010/NLA 
 

1. You will receive the Download Manager software on a USB stick with a Serial Number. 
2. Install Download Manager software onto PC. 
3. Go to http://www.autoflame.com/download-manager/ and request an Activation Code using the Serial 

Number on the USB stick. 
5. If the Activation Code has not been given for that Serial Number, then we will send you the Activation 

Code for the unique License Code generated on your PC. If an Activation Code has already been sent 
for that Serial Number of Download Manager software, we will require a Purchase Order for a new 
Serial Number/Activation Code (part number MM80010NLB). Then submit a new request for an 
Activation Code using the new Serial Number given with the Order Acknowledgement. 

 
Download from website 
 

1. Go to the software section of Autoflame Tech website (tech.autoflame.org) and save Download 
Manager software to your PC. 

2. Install Download Manager software onto PC. 
3. We will require a Purchase Order for a new Serial Number (part no. MM80010/NLB). 
4. Go to http://www.autoflame.com/download-manager/ and request an Activation Code using the Serial 

Number provided in the Order Acknowledgement. 
 
Note: For each Serial Number, there will be one unique License Code, and therefore one Activation Code, so 
for each PC the Download Manager software is installed on, you will need a new Serial Number and Activation 
Code. The Serial Number (00001+) refers to the USB Stick with the Download Manager software provided 
with IR lead MM80010 and Serial Number (5000+) refers to the USB stick MM80010/NLA. If you have 
downloaded the software from the website, we will issue a new Serial Number (10000+) for MM80010/NLB. 
Please keep this on record for future reference.  
 
 
 
 
  

http://www.autoflame.com/download-manager/
http://www.autoflame.com/download-manager/
http://www.autoflame.com/download-manager/
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1.3. Installation 

The Download Manager software is supplied on a USB stick (MM80010 or MM80010/NLA). The software can 
also be downloaded from Autoflame Tech Website http://tech.autoflame.org/software/ 
Right click on ‘setup’ file (Application) and click on ‘Run as Administrator’. 
 

 
 

 
The Download Manager Setup wizard box will pop up. Click ‘Next’ to launch the installation process. 
 

 
 
  

http://tech.autoflame.org/software/
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The default installation location is: C:\Program Files (x86)\Autoflame\Download Manager\  
Click ‘Browse’ if you wish to change this location.  
Click ‘Next’ to start the installation. 

 

 
 
 

Now the installer is ready to install the software, click ‘Next’ to confirm. 
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The software installation has been completed. Click ‘Close’ to exit the installer. 
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1.4. Activation 

When opening the Download Manager software after installation, the Software License Manager will pop up. 
Enter your company name and click ‘Generate Licence Info.’ 
 
Click ‘Submit Request Online’ or go to www.autoflame.com/download-manager/ to request an Activation Code. 
Using the company name and the generated license code. 
 
Alternatively click ‘Copy Info to Clipboard’ if you want to send a request via email to Autoflame.  

 

 
 
From ‘Select a network device to lock activation to’ select an on board device on your PC to link the activation 
to. 
 
please note that this device must be present and active when using the download manager software, as the 
software will check the license against this selected device while the software is in use. If this device is 
unplugged or de-activated then the download manager will not run and the software license manager will pop 
up every time the you try to use the software. Therefore it is recommended that the selected device is built in 
to the PC or Laptop.  
 
Once you receive the activation code from Autoflame, enter that in the Activation Code field and click ‘Activate’, 
the software has now been activated and ready for use.  
 
  

http://www.autoflame.com/download-manager/
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1.5. Connectivity 

Autoflame Download Manager software can communicate with the supported Autoflame devices via Infrared 
or Bluetooth. 
 

1.5.1. IR Connectivity 

The following tables explain what data can be accessed with IR connectivity.   
 

 Mk8 MM Mini Mk8 MM Mk8 EGA Evo Mk8 DTI 
Commissioning data upload      
Commissioning data download      
Long-Term Logs     
Store device screenshot     
Download diagnostics data     

 
Infrared connectivity requires the use of Autoflame IR Lead – Part number MM60010. This is a USB lead that 
can be plugged into a USB port on the user’s PC.  
 
When connecting to the Autoflame device to upload or download data, hold the IR Lead’s port within 5cm (2”) 
of the IR Data Port of the Autoflame device.  
 

 
 

Once the IR Lead is connected to the PC, go to the Tools menu on the Download Manager software and select 
‘Option’, make sure that the correct USB port number is selected under ‘COM Port’ and the ‘Port Type’ is set 
to ‘Standard USB IR Dongle’ 
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1.5.2. Bluetooth Connectivity 

Some Autoflame Systems support Bluetooth connectivity which allow users to download and upload data 
wirelessly via Bluetooth. This feature further simplifies the process of downloading the commissioning data as 
well as provides much faster download speed compared to IR. 
 
Bluetooth connectivity requires no special hardware and can utilise the on-board Bluetooth module on the 
user’s PC or laptop to connect to the Autoflame devise.  
 
Please note that Bluetooth connectivity is only supported on limited Autoflame devises and can be used to 
upload/download certain features only. The following tables explain what data can be accessed with Bluetooth 
connectivity.   
 

 Mk8 MM Mini Mk8 MM Mk8 EGA Evo Mk8 DTI 
Commissioning data upload      
Commissioning data download      
Long-Term Logs     
Store device screenshot     
Download diagnostics data     

 
This feature is currently available on all Mk8 DTIs and Mk8 MMs with serial number 3,000 onwards, please 
contact Autoflame if you are not sure about your devise’s compatibility.  
 
Benefits:  
 

• No need to be very close to the Autoflame device, just anywhere within 20 metre radius. 
• No need for special hardware or IR lead, the standard Bluetooth module on your PC can be used, if 

this is not available, an external Bluetooth device can be utilised (Bluetooth USB dongle for example). 
• Superior download speed with more reliable connection compared to IR. 
• Works on any PC, Laptop or Surface PC running windows 7, 8 or 10, both 32 or 64 bit versions. 

 
Pairing Autoflame Devise with your PC 
 
The Autoflame device and your PC must be “Paired”, this process needs to be done once for every device and 
it doesn’t need to be repeated for making future uploads/downloads from the same device using the same PC. 
 
To pair the devices, first the Bluetooth Module on your Autoflame device must be enabled:  
 

• On the Mk8 MM; in Online Changes, go to Parameter 84 and set it to 1 ‘Enabled’. 
• On the Mk8 DTI; go to Edit Configuration, select Settings and change Setting 9 to 1 ‘Enabled’. 
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Now the Bluetooth connectivity on your PC must be enabled. Go to ‘Bluetooth & other devices’ and make sure 
Bluetooth is turned on. 
 

 
 
 
Navigate to: Control Panel\All Control Panel Items\Devices and Printers 
Click ‘Add a Device’, The PC will search for all available devices with Bluetooth connectivity.  
 

 
 

In this example the Autoflame device name is ‘AF MM8 S/N:3387’ which shows the device type (Mk8 MM) and 
the device’s serial number (3387), select the device and click ‘Next’, the system will install the necessary 
drivers for the Bluetooth device and both devices will be paired.  
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Once finished the Autoflame device will be listed with the other devices paired with your PC.  
 

 
 

 
Right click on the device and select ‘Properties’, go to the “Services” tab and make sure that ‘Serial Port SPP 
Serial Port’ box is ticked, if not tick it and click ‘OK’. 
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Select the ‘Hardware’ tab, under ‘Device Functions’, you should now be able to see the COM port number 
listed next to ,Standard Serial Over Bluetooth Link, (COM10 in this case). Click ‘OK’ to close the window.  
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Now open Autoflame Download Manager software, from Tools menu, select ‘Options’.  
 

 
 
 
Under ‘Serial Port’, select the correct COM port, in this case it is ‘COM10’. 
Change the “Port Type” to ‘Bluetooth Adapter’. Click ‘OK’.  
 

 
 
 
Now to take a download from the paired device, click ‘Download’, fill in the download information and click 
‘Start’.  
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Download is taken via Bluetooth.  
 
To do an Upload via Bluetooth: 
 

• Mk8 MM – The MM must be on the IR Upload screen in Commission Mode. 
• Mk8 DTI – The DTI must be on the IR Upload screen in ‘Edit Configuration’. 

 
The exact same procedure apply as with an upload via IR Lead.  
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1.6. Downloading/Uploading Commission Data 

1.6.1. Downloading 

Before taking a download of a supported Autoflame device, you will need to create a Site, you will not be able 
to take a download if no site exists. 

 
Click on ‘File’ and then ‘Site’ or click on the  tab. Type a Site name. You could also add a download to an 
existing site by selecting that site from the drop-down menu.  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 

Right click on the new ‘Site’ and click ‘Start Download’, or click on the  tab, or select ‘Download’ from ‘File’ 
menu. Type the Engineer’s name, and choose the Site. Here, you can add notes for that commission data 
download. 

 
Now make sure that the connectivity is established as per section 2.3. Click ‘Start’  
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Once the data transfer is complete, an overview of the commission data download will appear on the Download 
Manager program. 
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1.6.2. Uploading  

Click on the commission data file you wish to upload to the supported Autoflame device, right click and select 
‘Upload’, or click on , or select ‘Upload’ from ‘File’ menu. Select which data you wish to upload to the 
Autoflame device.  
 

 
 
To upload commission data to the supported Autoflame device;  
 
On the Mk8 MM and Mini Mk8 MM, go into Commissioning mode and enter the password. In the Commission 

Mode screen press . 
 
On the Mk8 DTI, go to ‘Configure’, then ‘Edit Configuration’, enter the DTI commission password and press 

 
 
On the Mkk8 EGA Evo, go to ‘Configure’ then ‘Commission’ enter the EGA commissioning password and press 

 
 

Make sure that connectivity is established between the PC and the Autoflame device, click ‘Start’ on the 
Download Manager. Once the upload is complete, the Autoflame device will restart. 
 
Once the Autoflame device starts, it will go automatically to commission mode for the settings to be checked 
by the commissioning engineer, the device need to be restarted again to go into normal operation mode.  
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1.6.3. Convert Mk7/Mk6 Download to Mk8 Compatible Download  

Autoflame Download Manager software allows users to convert commissioning data downloads from older MM 
controllers to work on Mk8 controllers 
 
The software allows the conversion of: 
 

• Mini Mk7 MM download to work on a Mini Mk8 MM.  
• Mk7 MM download to work on a Mk8 MM. 
• Mk6 MM download to work on a Mk8 MM. 

 
This feature is particularly useful for further simplifying the process of upgrading older MM controllers to the 
Mk8 MM generation controller allowing the use of the same commissioning data without having to fully 
commission the new MM from scratch. 
 
To convert a Mini Mk7 MM download, from Tools menu, select ‘Convert Mini Mk7 Download for Mini Mk8’ 
To convert a Mk6 or Mk7 MM download, from Tools menu, select ‘Convert MM Mk6 or Mk7 Download for MM 
Mk8’ 
 

 
 

Choose the file to open from the location where it is saved on your PC. A dialogue box will appear to indicate 
what options/parameters must be reviewed, see example below: 
 

 
 
Click on the option/parameter and change the setting relevant to the Mk8 MM or Mini Mk8 MM. 
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Once a listed option/parameter has been reviewed, it will change from ‘No’ to ‘Yes’ under the ‘Checked’ 
column. After reviewing all the listed options/parameters, click ‘OK.’  
 

 
 
 
After checking all options and parameters, the download is now ready to be uploaded. 
 
 
Warning: It is the responsibility of the commissioning engineer to check all commissioning data are 
set correctly. Including all options and parameters. 
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1.7. Importing/Exporting a Download 

1.7.1. Importing Download 

 
To open an existing commission data file, go to ‘File’ and click ‘Import Download’ or and choose the file to 
open. 
 

1.7.2. Exporting Download 

To save a commission data file, go to ‘File’ and click ‘Export Download’ or  and choose which location to 
save the download. 
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1.8. Unlocking Mk8 MM Expansion Features 

If you wish to use an Expansion Feature on the Mk8 MM, the feature must be unlocked first before it can be 
used, for this an unlock code must be purchased; the table below shows the part numbers for the unlock codes 
for each available Expansion Features. The unlock codes are specific to the serial number of the Mk8 MM and 
are not interchangeable between the Mk8 MM units.  
 

Unlockable Software Feature Part Number 
Autoflame Water Level MK8001 
Analogue Water Level (requires Autoflame Water Level) MK8002 
Top Blowdown MK8003 
Bottom Blowdown MK8004 
Draught Control MK8005 
Direct Modbus MK8006 
First Out Annunciation MK8007 
Fully Metered Combustion System MK8008 
Heat Flow (Steam Flow + Hot Water Flow) MK8009 
Change on the Fly Fuel Changeover (COF) MK8010 
Setpoint Schedule MK8011 

 
 
When sending a purchase order for an unlock code for a Mk8 MM Expansion Feature, please make sure to 
include the serial number of that Mk8 MM so that the correct unlock code can be provided.  
 
Once the code is received, follow the following steps to unlock the Expansion Feature: 
 

1. On the Download Manager, from Tools menu, select ‘Unlock MM Features’ 
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2. Copy and paste the unlock code in the ‘Enter Keys’ column. If you have more than one code you can 
paste all of them to unlock multiple Expansion Features at the same time.  

 

 
 
 

3. In Commission Mode on the Mk8 MM, press .  
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4. Make sure that connectivity is established as per section 2.3 and click ‘Send’ on the Download 
Manager Unlock MM Features box.  

 
5. One the unlock code has been sent, the Download Manager will show a message to indicate how 

many keys have been accepted and how many rejected. 
 

 
 

6. The expansion features will show as ‘unlocked’ on the Mk8 MM for the codes that have been accepted. 
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1.9. Operation Data Monitoring and Analysis  

Autoflame Download Manager software allows the user to download and view diagnostic information stored 
onboard the Mk8 & Mini Mk8 MMs. This feature provides in depth diagnostics information which can help 
engineers and technicians diagnose and address faults and errors on-site more quickly and effectively. 
 
This feature provides detailed information and history for the following: 
 

• Processor Temperature 
• Mains frequency  
• Analogue Supply Voltage 
• Expansion Board Analogue Supply Voltage  
• Processor Temperature 
• Mains Current  
• Mains Power Factor 
• PCB Temperature  
• Fused 12V Supply  
• Fused 13.5V Supply 

 
 
To download the diagnostics data, go to ‘Tools’ menu and select ‘Monitor Data View and Download’. 
 

 
 

The ‘Monitor Data View and Download’ dialogue box will open, select ‘Download’ then ‘Download from 
Device’, the following dialogue box appears: 

 

 
 

Click ‘Start’ to Start the download.  
 

 
 
 
 
  



1      Download Manager  
 
 

Autoflame Mk8 PC Software Guide                Page | 30  

Once the download is complete, the following information will be displayed: 
 

 
 
The data is displayed in the form of an interactive graph. Which shows the maximum, minimum and average 
values of the relevant data. You can click on any data on the side menu to display the data on the graph. 
 
By positioning the mouse curser on a point on the curve in the graph, the specific data for that point will be 
displayed. 
 

 
 
 
To zoom into an area in the graph, use the mouse curser in a click & drag motion. 
 
Click ‘File’ then ‘Save’ to save the diagnostic file onto your PC. 
The diagnostics data is stored as a (.dat) file. To re-open a saved file, from the ‘Monitor Data View and 
Download’ viewer, select ‘File’ and ‘Open’, navigate to the file location, select the file and click ‘Open’. 
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1.10. Downloading Long Term EGA Data 

Up to 3 years’ worth of data can be stored internally onboard the EGA including emission gases, pressures, 
atmospheric pressure, temperatures, efficiency, fuel usage and much more.  
 
Autoflame Download Manager allows the user to download the Long-Term logs from the Mk8 EGA Evo. It 
allows the output of up to 3 years of raw data via IR port to PC for viewing and manipulation in Excel with 
Custom-designed emissions graphing spreadsheets to simplify analysis. 
 
This feature is only available for the Mk8 EGA Evo, part #MM82004/E and #MM82004/EPA. 
 
Long-Term Logs can be downloaded for the following: 
 

Exhaust Temperature 
HSL Temperature 
Cell Temperature 
Pre-Heat Temperature 
Ambient Temperature 
Chiller Temperature 
Inlet Pressure 
Barometric Pressure 
02 Concentration 
CO2 Concentration 
CO Concentration 

NO Concentration 
NO2 Concentration 
NOx Concentration 
SO2 Concentration 
Fuel Flow 
Efficiency 
02 Mass 
CO2 Mass 
CO Mass 
NO Mass 
NO2 Mass 

SO2 Mass 
H2O Mass 
N2 Mass 
Fuel 1 Total 
Fuel 2 Total 
Fuel 3 Total 
Fuel 4 Total 
Powered-On 
Sampling 
Firing 

 
 
From Tools menu, select ‘ Download Long Term Logs’  
 

 
 
 
Make sure that connectivity is established between your PC and the EGA, the following dialogue box  will be 
opened, click ‘ Get Log Info’  
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A list of data will be established, select that data that you want to download or click ‘All’ if you want to download 
all the data. Click ‘Start’ to begin the process of downloading the data. 
 
The time it takes to complete the download depends on how much data is stored on the EGA, please note that 
downloading long term logs from the EGA may take up to 30 minutes. 
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Once the download is done, a Save As dialogue box will open, enter a name for the download and select a 
path to store the file in, click ‘Save, to save the file.  
 

 
 
 
The EGA long-term logs are download and stored in an excel file, this can be viewed and edited as required.  
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1.11. Taking and Storing DTI Screenshot 

Download Manager software allows the user to take and store a device screenshot from any screen on the 
Mk8 DTI.   
 
Navigate to the required screen on the Mk8 DTI.  
From the ‘Tools’ menu, select ‘Take Device Screenshot’  

 

 

The Screenshot dialogue window will appear, make sure that connectivity is established between the DTI and 
your PC as per section 2.3 Click ‘Start’ 
 

 

Once the screenshot is taken, a ‘Save As’ dialogue box will be opened, name the screen shot and select where 
you want to save it, click ‘Save’. 
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1.12. Troubleshooting 

1.12.1. No COM Ports Detected 

If the warning ‘No COM ports detected’ appear when opening the Download Manager, please check your COM 
port configuration. 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 
 
 
 

 
Go to Device Manager on your PC and expand Ports (COM & LPT) 
Check the port number of the ‘Prolific USB-to-Serial Comm Port (COMxx) 
Make sure that matches the COM Port setting on the Download Manager software.  
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1.12.2. Using Old Type IR Lead 

If you are using an early version of the IR lead, you might run into an issue where the Download Manager 
might not recognise the IR lead. This is caused by compatibility issues of the IR lead’s driver software.  
 
Windows might automatically install a driver that does not support the early version of the IR leads. To make 
older IR leads work with the Download Manager software you must manually install the correct driver version 
for the IR lead. Windows automatic driver updates must also be disabled to prevent Windows from changing 
the driver version in the future.  
 
Please follow these steps to install the compatible driver and disable Windows automatic driver updates: 
 
Check the current COM Port driver’s version 
 
From Control Panel on your PC, go to Device Manager  
Expand ‘Ports (COM & LPT) 
If you see ‘PL2303HXA PHASED OUT SINCE 2012, PLEASE CONTACT YOUR SUPPLIER’ this means an 
incompatible driver is installed for the IR lead.  
Right click on it and Select ‘Properties’ 
 

 
 
From Properties, select ‘Driver’ tab  
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Note the Driver Version, the compatible version is 3.4.25.218, if you have any other version then you have the 
wrong, incompatible driver installed and the IR lead will not work, you need to have the correct driver version 
installed manually. 
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Disabling Windows Automatic Driver Updates 
 
This is necessary to prevent windows from automatically changing the Driver’s version in the future. 
Navigate to Control Panel > All Control Panel Items > System 
 

 
 
Click Advanced System Setting  
From the System Properties, select the Hardware tab 
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In the Device Installation Settings dialogue box, select ‘No’ and click ‘Save Changes’  
 

 
 
 
To uninstall the incompatible COM Driver version 
 
Keep the IR Lead plugged in to your PC 
Open Device Manager 
Right click ‘PL2303HXA PHASED OUT SINCE 2012, PLEASE CONTACT YOUR SUPPLIER’ 
Select ‘Uninstall Device’ 
Tick ‘Delete the driver software of this device’  
Click Uninstall 
 

 
 
Once the uninstallation process is complete, restart you PC. 
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Install the correct driver: 
 
Keep the IR Lead plugged in to your PC 
Go to the software section of Autflame Tech website http://tech.autoflame.org/software/ 
Download ‘IR Lead Driver for Windows 8 & 10’  
If you don’t have access to Autoflame Tech Website, please contact Autoflame.  
Unzip the folder 
Right click ‘ACT-IR224UN-DriverInstaller_v1.5.0-20111021’ 
Select ‘Run as administrator’  
If asked for installation permission, click ‘Yes’  
 

 
 

On the PL-2303 Driver Installer Program dialogue box, select ‘Modify’ and click ‘Next’ 
 

http://tech.autoflame.org/software/
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Once the installation has been completed, the PC must be restarted. 
On the PL-2303 Driver Installer Program dialogue box, keep ‘Yes, I want to restart my PC now’ selected. 
Click ‘Finish’, your PC will restart.  
 

 
 
Once the PC starts up, go to Device Manager,  
Check the current COM Port driver’s version. 
From Control Panel on your PC, go to Device Manager  
Expand ‘Ports (COM & LPT) 
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Right click ‘Prolific USB-to-Serial Comm Port (COM#) 
Select Properties and go to the Driver tab. 
The correct Driver version (3.4.25.218) is now installed  
 

 
 

Open the Download Manager software, now the software should be able to recognise the COM Port and IR 
lead.  
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2. MK8 SIMULATOR 

2.1. Overview and Compatibility 

Autoflame Mk8 Simulator software provides fully simulated, fully configurable version of the Autoflame devices 
listed below on the user’s PC, including all the features, screens and expansion options, it shows the controllers 
in full running mode. 
 

• Mk8 MM 
• Mk8 Mini MM 
• Mk8 EGA Evo 
• Mk8 DTI 

 
It is very useful to demonstrate the features and capabilities of Autoflame systems as well as providing great 
training tool.  
 
Autoflame Mk8 Simulator software is compatible with Windows 7, 8 and 10 in both 32 & 64bit. The software 
must be installed in Administrator mode. 
 
It is recommended to install the Mk8 Simulator software on a Windows PC with touch screen functionality (for 
example: Microsoft Surface®) as the screen will operate in the exact same way as on the Autoflame Mk8 
systems. However if this is not possible, normal mouse control can be used.  
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2.2. Installation  

Open the installation folder, right click on ‘Mk8SimulatorSetup’ file and select ‘Install’ 
 

 
 
 
The Mk8 Simulator software installation wizard box will appear, click ‘Next’. 
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Specify a location for the software on your hard drive, the default location is: 
C:\Program Files (x86)\Autoflame\Mk8 Simulator 2019 
Click ‘Browse if you wish to change the location.  
Click ‘Next’. 
 

 
 

 
The installer is now ready to install the software, click ‘Next’ to confirm installation.  
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Once the installation process is complete, click ‘Close’.  
 

 
 
 

 

2.3. Activation  

When the software is run for the first time, a License dialogue box will appear to prompt the user to activate 
the software. 
 

 
 
 
Copy the License Code and send it to Autoflame with request for Mk8 Simulator Activation Key, once the 
Activation Key is received, enter it in the Activation Key field and click ‘Activate’. 
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2.4. Mk8 Simulator Screens 

When the Mk8 Simulator is opened, the Mini Mk8 MM simulated screen will be displayed as default.  
You can switch between the devices by clicking the button for the required device from the top left corner or 
selecting it from View menu.  
 
The buttons and options on the simulator work in the same way as in the real controller.  
 

 
 
 

 

Mk8 Mini MM 

Mk8 DTI 

Mk8 MM 

Mk8 EGA 

Full Screen Mode  

Quit the Simulator 
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Mk8 MM 
 

 
 
Mk8 EGA Evo 
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Mk8 DTI 
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3. Mk8 Skin Configurator 

3.1. Overview and Compatibility 

For marketing or promotion reasons, Tech Centres, OEMs or End Users might want to upload their own logo, 
slogan or custom graphics to the MM screen, the Mk8 Skin Configurator software enable users to do so with 
simple steps.  
 
This software enables users to create custom graphics to be uploaded to: 
 

• Mk8 MM 
• Mk8 Mini MM 
• Mk8 EGA Evo 
• Mk8 DTI 

 
Mk8 Skin Configurator software can be downloaded from the software section of Autoflame Tech website: 
http://tech.autoflame.org/software/ 
 
There is no activation required for the Skin Configurator Software.  
 
Autoflame Mk8 Configurator software is compatible with Windows 7, 8 and 10 in both 32 & 64bit. The software 
must be installed in Administrator mode. 
 
 
  

http://tech.autoflame.org/software/
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3.2. Installation  

Open the installation folder, right click on ‘Setup’ file and select ‘Run as administrator’  
 

 
 
The Mk8 Skin Configurator software installation wizard box will appear, click ‘Next’. 
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Specify a location for the software on your hard drive, the default location is: 
C:\Program Files (x86)\Autoflame\Mk8 Skin Configurator 
Click ‘Browse if you wish to change the location.  
Click ‘Next’. 
 

 
 

 
The installer is now ready to install the software, click ‘Next’ to confirm installation.  
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Once the installation process is complete, click ‘Close’.  
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3.3. Generating Custom Skins 

3.3.1. Target Device 

From Target Device menu, select: 
 

• Mini MM Mk8 for Mini Mk8 MM graphics. 
• MM Mk8 for Mk8 MM, Mk8 DTI, Mk8 EGA Evo graphics.  

 
You could opt to remove the Autoflame logo by unticking ‘Show Autoflame Logo’ under ‘Options’ on the right 
side of the window.  
 
If you want to position the graphics in the centre of the screen, tick ‘Centre Image’ box under ‘Options’ on the 
right side of the window.  
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3.3.2. Splash Screen  

The Splash Screen is the main screen when the Autoflame device starts. 
 
Use the computer mouse in drag and drop action to upload your logo, company slogan or custom graphics 
as desired.  
 

 

3.3.3. System Configuration Screen 

Use the computer mouse in drag and drop action to upload your logo, company slogan or custom graphics 
as desired.  
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3.3.4. Screen Saver  

 
 

3.3.5. Theme Colours 

The button colours can be customised in this screen, choose the top and bottom colours, LED colour and 
text colour.  
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If the colour you want is not available in the basic colours box, click ‘Define Custom colour’, pick the colour 
you want and click ‘Add Custom Colour’. 
 

 
 

3.4. Uploading Custom Skin 

Once you complete uploading the graphics and setting the colours, you can upload the custom graphics to 
the Autoflame device, to do so: 
 
Remove the SD card from the Autoflame unit, please refer to the relevant technical manual to find out how to 
remove the SD card, insert the SD card into your PC.  
Select ‘Generate Skin‘ from File menu. 
 

 
 
Navigate to the SD card and click ‘OK’  
 

 
 

Note: Save the file directly to the SD card and not in any sub-folder. 
 
Extract the SD card from your PC and insert back into the Autoflame unit.  
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Now the relevant Autoflame device screen displays the custom graphics. 
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